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Campus Computing
News
Laptop Security During the Holidays

By Gabe Marshall, CITC Information Security Analyst

With the holidays just around the corner, it is important that UNT faculty and staff remember
 to safeguard their resources. Many of you may consider taking home a laptop from work,

bringing home a flash drive with UNT data, or even traveling with a personal laptop so that you
 can work over the holidays. Before you do, you need to be aware that if you are traveling with a
 university owned laptop, or carrying UNT data on any type of personal storage device, you are
 fully responsible for providing adequate protection to it.

The following tips will help prevent the possibility of your laptop or personal media device
 being stolen.

Preventing Laptop Theft

When traveling, make sure your laptop is with you everywhere you go. A laptop can be stolen
 within seconds of neglect. Laptop theft can occur at any time and place, most commonly at
 home, in cars, hotel lobbies, airports, etc.

If you happen to be flying over the holidays, be especially cautious when you are going through
 security checkpoints and while waiting to board your plane. Thieves often prey on people at
 these points. It is also recommended to bring your laptop on board instead of checking it with
 your luggage. If you plan on bringing your laptop home, make sure it is kept out of plain view
 whenever not in use. Thieves typically only steal what they can immediately see. While on the
 road, keep in mind that locking your laptop in your car is not a sufficient safeguard, especially
 when left in plain view. If for some reason you must leave your laptop in a car, make sure it is
 locked in the trunk.

Many new laptops may come with anti-theft devices such as bio-metric scanners, motion
 detection alarms, security cables, tracking software, etc. If your laptop is equipped with one of
 these, make sure it is in use. If your laptop does not come with any theft deterrents, you might
 want to consider purchasing one if approved by your network manager.

Lastly, if a theft does occur, please report it immediately to the police as well as your network
 manager. You should also make sure the UNT Information Security Team has been contacted
 as well. Immediately reporting incidents is required according to policy, and will reduce the
 likelihood of data loss.

Sensitive Data Protection

First and foremost it is strongly advised to not store any sensitive data on your laptop and/or
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 handheld media device unless absolutely necessary. Examples of sensitive data may include but
 is not limited to files containing credit card numbers, social security numbers, employee id
 numbers, and EUID's. If it is imperative that you take home sensitive data containing sensitive

data, you are required to properly encrypt it.

TrueCrypt, a popular free encryption application, can be used with relative ease which will
 provide adequate security. A simple tutorial can be found
here. For more information about
 securing your sensitive data through encryption, read our article on
UNT Data Encryption
 Recommendations, or contact your network manager. You can also contact the UNT
 Information Security Team at security@unt.edu or by dialing 565-7800.

Quick Tips

Use any included security devices and/or features.

Never leave usernames or passwords in your carrying case.

Store your serial number in a safe place.

Lock your office door.

Keep an eye on your laptop at all times.

Laptop Theft Statistics

Laptop thefts continue to increase yearly; over 1.5 million laptop thefts per year.

Last year reported thefts increased by 81%. -- The Cost of Data Breach. - Ponemon Institute,
 LLC, 2007

On average, a stolen laptop has been estimated to cost $1200 in hardware losses, and       

around $9000 in information losses. - Safeware Insurance, 2004

A laptop is reported stolen every 50 seconds.

97% of stolen computers are never recovered. - Federal Bureau of Investigation (2007)

Laptop theft is second most common crime, just after identity theft.

Over 70% of thefts occur in cars and coffee shops.

Laptop theft has been attributed to 59% of computer attacks in government agencies,

corporations, and universities during 2003. - Baseline, 2004
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 Winter Break
Hours
By Claudia Lynch,
Benchmarks Online Editor

The University is
officially closed December 24 through January 1.*  Following are the
 hours for Computing and Information Technology Center-managed facilities during the
 break.

The Helpdesk plans to be open as follows:


Normal schedule for Sunday, December 16 – Sunday, December 23.
Monday, December 24: 8 a.m. – 5 p.m.
Tuesday, December 25: Closed
Wednesday, December 26 - Monday, December 31: 8 a.m.- 5 p.m. (Possibly
 open 5 p.m. – Midnight if staff members are available to work those hours.)
Tuesday, January,1: Closed
Wednesday, January 2: Resume normal hours.

The ACS General Access/Adaptive Lab (ISB 110): 

Friday, December 14: Close at 6:00 pm 

Saturday, December 15: 9 a.m. - 6 p.m.

Sunday, December 16: Closed
Monday, December 21 - Friday, December 21: 9 a.m. - 6 p.m.
Saturday, December 22 - Tuesday, January 1: Closed
Wednesday, January 2 - Friday, January 4: 9 a.m. - 6 p.m.
Saturday, January 5 & Sunday, January 6: Closed



Monday, January 7 - Saturday, January 12: 9 a.m. - 6 p.m.

Sunday, January 13: 1-10 p.m.

Monday, January 14: Resume normal hours

Hours for Other Campus Facilities

General Access Labs

 WILLIS:

Friday, December 14: Close at 5:50 p.m. 

Saturday, December 15: 9 a.m.- 5:50 p.m. 

Sunday, December 16: Closed


Monday, December 17 - Friday, December 21: 8 a.m. - 5:50 p.m. 

Saturday, December 22 - Tuesday, January 1: Closed


Wednesday, January 2 - Friday, January 4: 8 a.m.- 5:50 p.m. 

Saturday, January 5 & Sunday, January 6: Closed  

Monday, January 7 - Thursday, January10: 8 a.m. - 5:50 p.m. 

Friday, January 11: Closed  
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Saturday, January 12: 9 a.m.- 5:50 p.m. 

Sunday, January 13: Open at 1 p.m., Resume 24hr schedule

SLIS:

Friday, December 14: Close at 6 p.m.
Saturday, December 15 - Sunday, January 6: Closed
Monday, January 7 - Friday, January 11: 10 a.m. - 6 p.m.
Saturday, January 12 & Sunday, January 13: Closed
Monday, January 14: Resume normal hours
 

MUSIC:

Saturday, December 15 - Sunday, January 13: Closed
Monday, January 14: Resume normal hours

PACS Computing Center (Chilton Hall):

Friday, December 14: close at 6 p.m.
Saturday, December 15 - Sunday, January 13: Closed

Monday, January 14: Open 7 a.m., resume normal hours

SOVA:

Saturday, December 15 - Sunday, January 13: Closed
Monday, January 14: Resume normal hours

COE:

Friday, December 14: Close at 5 p.m.
Saturday, December 15 - Sunday, January 13: Closed
Monday, January 14: Open at 7 a.m., resume normal hours

COBA:

Friday, December 14: Close at 4 p.m.
Saturday, December 15 - Friday, January 11: Closed
Saturday, January 12: Resume normal hours

CAS:

GAB 550

Friday, December 14: Close at 5 p.m.
Saturday, December 15 - Sunday, January 13: Closed
Monday, January 14: Resume normal hours 

 
Terrill 220

 

Friday, December 14: Close at 5 p.m.
Saturday, December 15 - Sunday, January 13: Closed
Monday, January 14: Resume normal hours
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Wooten 120

 

Friday, December 14: Close at 5 p.m.
Saturday, December 15 - Sunday, January 13: Closed
Monday, January 14: Resume normal hours

UNT Dallas Campus - 155A


Monday, December 17 -  Friday, December 21: 8 a.m. - 6 p.m.

Saturday, December 22 - Tuesday, January 1: Closed

Wednesday, January 2 - Friday, January 4: 8 a.m. - 6 p.m.

Saturday, January 5 & Sunday, January 6: Closed

Monday, January 7 - Friday, January 11: 8 a.m. - 6 p.m.

Saturday, January 12 & Sunday, January 13: Closed

Monday, January 14: Resume normal hours

Engineering General Access Lab (englab@unt.edu, Research Park, B129, 891-
6733)

Friday, December 14: Close at Noon
Saturday, December 15 - Sunday, January 13: Closed
Monday, January 14: Open at 9 a.m., resume normal hours

* InHouse recently published
the article,
Winter break brings many changes to the campus. It
 includes a list of closures and electrical power shut downs scheduled to occur over the
 Winter Break. Also, the article
Offices, departments have moved or plan a spring relocation,
 has information about all the changes you can expect to see when you return from the
 holidays.

You might want to register
here to receive an email or text page for a UNT and/or local
 school district closing, should they occur.

And don't forget ...
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EDUCAUSE 2008 and More

 


By Claudia
Lynch, Benchmarks Online Editor

Time marches on and so does the scheduling of EDUCAUSE conferences. Before we move
 on to 2008, you may remember that EDUCAUSE 2007 was ...

The good news is that, even if you missed the
 conference,   EDUCAUSE 2007 resources are now
 available online. According to a recent e-mail
 EDUCAUSE sent out, you can now access numerous
 dynamic resources from this year's annual conference.
 Several are already online, and more will be added in the
 future: 

 

Streaming digital videos of selected general and featured speaker sessions:

Things I've Screwed Up—and How!; Gregory Jackson, Vice President and CIO,
 University of Chicago, (2007 EDUCAUSE Leadership Award winner)

Information Security: Ten Trends; Bruce Schneier, Chief Technology Officer, BT
 Counterpane, Inc., and Author of Beyond Fear

The Adventures of Katz and Dodds: Travels into Several Remote Nations of the
 World; Richard Katz, EDUCAUSE Vice President, and Ted Dodds, CIO at the
 University of British Columbia

Learning to Drive (and Other Lessons Learned Along the Way); Brian Hawkins,
 EDUCAUSE President and CEO


Also:

Audio podcasts of general sessions and interviews with speakers and attendees.
Photos of people, places, and conference happenings on Flickr.
Session presentation materials—PDFs and PowerPoint slides.
2007 Awards Program video and winner information.
Check out the full collection of
EDUCAUSE 2007 resources.
You also can
purchase the comprehensive set of EDUCAUSE 2007 recordings on CD

or DVD.

 
Upcoming EDUCAUSE Conferences
 

Click on the graphics below to find out all the details.
 

http://www.unt.edu/benchmarks/archives/2007/december07/index.htm
http://www.unt.edu/benchmarks/archives/2007/december07/index.htm
http://www.unt.edu/benchmarks/archives/subscribe.htm
http://www.unt.edu/benchmarks/archives/subscribe.htm
http://www.unt.edu/benchmarks/archives/subscribe.htm
http://www.unt.edu/benchmarks/archives/subscribe.htm
mailto:lynch@unt.edu
mailto:lynch@unt.edu
http://www.educause.edu/email/e07/link.asp?name=pro_1
http://www.educause.edu/email/e07/link.asp?name=pro_2
http://www.educause.edu/email/e07/link.asp?name=pro_3
http://www.educause.edu/email/e07/link.asp?name=pro_3
http://www.educause.edu/email/e07/link.asp?name=pro_3
http://www.educause.edu/email/e07/link.asp?name=pro_4
http://connect.educause.edu/browse/content/node/691,5576/list?sort=desc&order=Year
http://www.flickr.com/photos/tags/educause2007/
http://www.educause.edu/e07/program/11082
http://www.educause.edu/awardsate07
http://connect.educause.edu/term_view/EDUCAUSE2007
http://www.educause.edu/email/e07/link.asp?name=pro_5


EDUCAUSE 2008 and More

http://www.unt.edu/benchmarks/archives/2007/december07/EDUCAUSE.htm[4/26/16, 12:58:32 PM]


Empowering Community Through Technology

February 20–22 • Houston, Texas

 
 




 

Originally published, December 2007 --
Please note that information published in Benchmarks Online is likely to degrade over
 time, especially links to various Websites. To make sure you have the most current information on a specific topic, it may be best
 to search the UNT Website -
http://www.unt.edu . You can also search
Benchmarks Online -
 http://www.unt.edu/benchmarks/archives/back.htm as well as consult the UNT Helpdesk -
http://www.unt.edu/helpdesk/
 Questions and comments should be directed to benchmarks@unt.edu

 

Return to top

http://www.educause.edu/swrc08
http://www.educause.edu/e08
http://www.educause.edu/e08
http://www.unt.edu/
http://www.unt.edu/benchmarks/archives/back.htm
http://www.unt.edu/helpdesk/
mailto:benchmarks@unt.edu


An Information Technology Christmas

http://www.unt.edu/benchmarks/archives/2007/december07/ITChristmas.htm[4/26/16, 12:58:33 PM]

Skip Navigation Links

Page One


Campus
 Computing

 News


Winter Break
 Hours


EDUCAUSE
 2008 and More

An Information

Technology
 Christmas


Today's
 Cartoon


RSS
Matters


The
Network
 Connection


Link
of the
 Month


Helpdesk FYI


Short
Courses


IRC
News


Staff
Activities

Subscribe to
 Benchmarks

 Online

    

An Information Technology Christmas*
By Cathy Gonzalez, EIS Training, Communications, and Administration Manager

Some of us celebrate the Christmas season and others of us do not; however, December is
 known as the month of thoughtful deeds and gift exchange. For many people a Christmas
 wish list emphasizes technology and the latest electronic gizmo; you begin the search for the
 ultimate Christmas gift. Recently I began thinking of a different spin on how the holiday

season and the topic of gift giving relate to the computing/IT world. What would it be like if
 you could give a gift that taps into your skill set and is not a drain on your bank account?

The following examples help provide an answer:

A story was published in a Seattle newspaper about a man, named Mark, who
 had made a trip to Mexico and saw an old man on the street, sitting behind a
 card table that bore a sign: "escritor
público"  (“public writer”).  Mark did not
 think much more about the old man until he was downtown at lunchtime one
 day and happened past a homeless lady standing by a mailbox.  She asked Mark
 if he could spare a stamp; she had made a birthday card for a friend out of old
 newspaper and wanted to mail it but had no envelope or stamp.  He took the
 letter and mailed it for her at his own expense. The next Saturday found Mark
 sitting behind a card table at the Urban Rest Stop in downtown Seattle, helping
 homeless men and women find the words to tell their loved ones how they are,
 where they are — and perhaps who they wish they could be. On his table he had
 placed a laptop and portable printer, a stack of paper and stamped envelopes,
 and a bowl of Hershey's kisses to break the ice. "We are in one of the most
 wired cities in the country," Mark was quoted, "and here are these homeless
 people wandering around without the means."  The chair in front of his story
 table didn’t stay empty long. Folks come in for a shower or some laundry. Then
 they spotted Mark, read his sign ("Want to write a letter?") and pause.

On a more personal note, when my son met his future in-laws for the first time,
 they were assigned to a Salvation Army shelter in a small Texas town. A small
 group of networked computers was available in the shelter to assist with job
 skills training. For seven months the network had not been working and half of
 the workstations consistently crashed. No technical support person could be
 found that would service the computers for the amount of money available in
 the shelter’s budget. In 4 hours my son had all of the machines working and
 network accessible. My son is not big on celebrating the holiday season but his
 gift of sharing his IT skills made it possible for many people to feel hope at this
 time of year.

A friend of mine started a volunteer program spending two Saturdays a month at
 retirement homes helping senior citizens use email services to communicate
 with loved ones not living close by. My friend guides the residents through
 logging in to their email and reading the nuggets of love that reside in each
 mailbox. Then time is taken to type replies for the stiff, arthritic fingers that can
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 no longer navigate a keyboard. Often the resident proudly says “I want to click
 the mouse on Send” and exclaim in a surprised voice to the next resident
 waiting in line about the amazing fact “I sent this for free!”  

One of my fondest memories in my early days of administering networks and
 supporting desktops was configuring a lab over several Saturdays that was to be
 used for job skills training.  The recipients of the training were victims of
 domestic violence.  Once I saw the immense appreciation of the lab’s users, I
 volunteered to participate in the instructional effort needed in the lab. Self-
esteem rose as computing skills increased.

By now I’m sure you are getting the picture of how an IT Christmas really can happen. The
 best part is these gifts last much longer than December.  For some people, they are life

experiences that will never be forgotten. What do you have hidden in your computing skill
 set that would make a wonderful gift for someone? Once you find it, wrap it up with
 sincerity and commitment, then deliver it with a smile. It will cost you far less but be worth
 much more than anything you will find at Best Buy or CompUSA!

 

* If this sounds a little familiar to you, it is an updated version of an article we printed in
	2004. Good stories are timeless, of course ... -- Ed.
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From "Today's Cartoon by Randy
Glasbergen", posted with special permission. For
 many more cartoons, please visit www.glasbergen.com.
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Don't Forget Our Monthly Columns!
By Claudia Lynch,
Benchmarks Online Editor

In addition to our feature articles, Benchmarks Online publishes monthly
 columns that are focused on specific aspects of computing here at UNT (and
 beyond, in some cases). Check out what is waiting for you this month:

By the Numbers - Not really a column, but a new feature, giving you a
 glimpse behind the scenes of the volumes of data, spam, etc. processed,
 managed, and otherwise handled here at UNT.

RSS
Matters - "RSS Matters" is the monthly column written by the
 Research and Statistical Support
Group in Academic Computing
 Services. Their articles focus on topics of a statistical and/or research
 methods nature. This month we have another "golden oldie" column,
 "Moderators and Mediators." Check it out!

The
Network Connection - "The Network Connection" may well be the
 longest running column in computer publishing history. Certainly in
 University of North Texas computer
publishing history.

This month, Dr. Baczewski questions Google's motives. Click on the
 Network Connection link above to read "Do no Apparent Evil."

Link
of the Month - As it says on the top of the "Link of the Month"
 page, "each month we highlight an Internet, USENET Special Interest
 Group (SIG), or similar mailing list(s) or Website(s)." Lately we have
 been confining ourselves to featuring UNT specific sites. A new Spam
 filtering system was installed last month. Click on the link above
 and check out "IronPort Spam Quarantine Help."

Helpdesk FYI - A new monthly feature from the CITC Helpdesk. Each
 month they will tackle a topic that has been of particular interest to

callers/visitors to the Helpdesk.
This month  Richard Sanzone talks
 about how to use "View Options in Microsoft Outlook."

Short
Courses - Every semester, Academic Computing Services (ACS)

offers short courses on computer-related topics, many of them having to
 do with statistical research. This column keeps you up-to-date on what is
 being offered and when as well as other training opportunities.

Short Courses are over for the semester, but if you have a
 group that needs a specific class, it may be possible to arrange
 a special class just for them . Click on the Short Courses link
 above for more information.

http://www.unt.edu/benchmarks/archives/2007/december07/index.htm
http://www.unt.edu/benchmarks/subscribe.htm
http://www.unt.edu/benchmarks/subscribe.htm
http://www.unt.edu/benchmarks/subscribe.htm
http://www.unt.edu/benchmarks/subscribe.htm
mailto:lynch@unt.edu
http://www.unt.edu/benchmarks/archives/2007/december07/index.htm#numbers
http://www.unt.edu/rss/
http://www.unt.edu/benchmarks/archives/2003/august03/columns.htm


Don't Forget Our Monthly Columns!

http://www.unt.edu/benchmarks/archives/2007/december07/columns.htm[4/26/16, 12:58:36 PM]

IRC
News - As their Webpage says, "the IRC is an advisory and
 oversight body created to foster communication and cooperation
 between and among UNT information resources providers and users."
 We publish the minutes of the IRC meetings each month, when they are

available. The minutes for   November 20, 2007 are available this
 month.

Staff
Activities - This column focuses on new employees, people who
 are no longer employed at the Computing and Information Technology
 Center, awards and recognitions and other items of interest featured
 here.
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By Dr.
Philip Baczewski, Director of  Academic Computing and User Services

Do no Apparent Evil

They brought it on themselves. A long time ago, Google was just a cool and really

comprehensive web search engine that a couple of guys at Stanford dreamed up. Back when
 Alta Vista was the hottest thing, Google crept onto the Web radar and eventually eclipsed all
 its search engine competitors.

This led from Google, the cool idea, to Google, the high-dollar corporation. When
 establishing their corporate identity, it was Google who averred that their corporate
 philosophy was to "do no evil." This still survives
in their corporate philosophy as, "You can
 make money without doing evil."


Google, the online search engine, is now Google, the online everything. Everything you
 need to find information, shop, entertain yourself, be productive, and communicate. And the
 best part is that
it's all free. Of course, so is the popcorn at many a neighborhood bar, so
 forgive me if I am somewhat skeptical of Google's motives in pursuing a business model
 that apparently generates no revenue directly from the majority of those who utilize the
 services which are provided. But, you have to admire the audacity of that business model.

	While I've always been a fan of Google's web search service and can't get by without Google
 Maps, I have resisted the allure of
GMail  or the many other services they offer. Recently,
 however, I was interested in Google Docs, a service to allow you to create and store
 documents online. The first thing I did was to read Google's
terms of service. I was surprised
 to find something, which although not downright evil, was somewhat disconcerting.

	Right there, tucked in under number 11 is the provision that while you get to retain
 ownership of your intellectual property, Google retains "a perpetual, irrevocable, worldwide,
 royalty-free, and non-exclusive licence to reproduce, adapt, modify, translate, publish,
 publicly perform, publicly display and distribute any Content which you submit, post or
 display on or through, the Services." In other words, if it passes through anything Google,
 they retain permanent rights to use it however they please without compensating you.

	Google
explains this clause as follows: 'We need to ensure that when you click the "Publish
 document" button, or use the "Invite collaborators" option, we have the license to carry out
 your wishes." Not exactly, because back in the terms of service, it states that this is for

"enabling Google to display, distribute and promote the Services", i.e. mostly for self
 promotion. This does not seem to be a completely honest explanation on Google's part. The
 next paragraph allows Google to make your intellectual property "available to other
 companies, organizations or individuals with whom Google has relationships" based on your
 consent to the terms of service.
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	It is interesting to note what rights Google allows you in regard to their intellectual property.
 This is covered in item 9 where you agree that Google owns "any intellectual property rights
 which subsist in the Services" and agree not to disclose any confidential information without
 their prior written consent. Apparently, this is a right they wish to reserve for themselves.

	You might say that Google has to get something in return for all that free space and service
 they are providing. I would agree. But is the exchange a fair and even (and non-evil) trade?
 At face value it would seem that your individual e-mail would be of relatively little
 monetary worth. A whole lot of people's e-mail, mined for current trends and preferences,
 would seem to be more useful for conversion into commercial currency. But once you enter
 the realm of documents and creative works, the stakes would seem to change.

	It is ideas which built the value of the Internet and you can't anticipate the value of ideas.
 Today's
submarine patents can cost technology companies millions or billions of dollars if
 enforced. You can't anticipate the future value of your idea, but you've already ceded Google
 free use of whatever that may be, perhaps the next "Google."

	I'm reminded of a
previous analogy which appeared in this column:

So welcome to the new economic world of intellectual property. The few largest
 entities such as Lord Disney and Count Viacom rule their international
 kingdoms with the support of lesser nobles such as Duke Bill-who-would-be-
king of Microsoft. Oh there are the lesser intellectual property holders such
 Baron Rupert and the Earl of Turner, and a whole hierarchy extending below
 them. There is even an intellectual property middle class -- the ones who hold a
 patent or have written a book and receive that infrequent and dwindling, but

aptly named royalty. The rest of us? That's right, we're just virtual serfs.


NOTE: the term "virtual serf" is hereby claimed as intellectual property by
 Philip Baczewski. The rest of you are on your own.

You might say that Google is providing a service in exchange for a right -- a simple
 commercial transaction. Feudal lords allowed serfs to farm their land in exchange for their
 labor or a share of their harvest -- a simple commercial transaction, except when you
 examine who held the power. Google "allows" us to farm their virtual lands, but who holds
 the power in that relationship?

 So please don't blame me for suggesting that Google is not all non-evil. It was the company,
 in their
SEC filings, that suggested they would hold themselves to a higher standard. Yet
 although their corporate philosophy includes the tenet that, "The need for information
 crosses all borders", they don't hold to that truth where the border to
China is concerned.

	I don't blame Google for maximizing their position in pursuing the business interests.
 However, I also think a higher standard would be for Google to explain their interests up
 front, rather than burying things in item 11 of a service agreement that they know most
 people will not read. You can make money without doing evil, but first you have to want to
 do so.
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Link of the Month
Each month we highlight an online mailing list or website. Frequently the link is
 associated with UNT.

IronPort Spam Quarantine Help

A new anti-spam software system was
installed last month, and everyone should
 have noticed a marked reduction in the amount of spam that is appearing in their
 mail boxes. It is a good idea to visit http://spam.unt.edu [log in with your EUID
 and password] on a regular basis, to make sure legitimate mail messages are not
 being blocked. Messages are kept for 15 days.

If you receive a spam message in your regular inbox, forward it, as an
 attachment, to spam@access.ironport.com and IronPort will tweak their spam
 detecting rules to block that kind of message in the future.

More information about using IronPort Spam Quarantine can be found by clicking
 on the word Help in the top left-hand corner of  the screen and then choosing
 Online Help after
you log-in to spam.unt.edu.

If you want to read up on IronPort Spam Quarantine without logging-in, you can
 visit:
https://spam.unt.edu/help/enduser_help .

If you need further information with regard to the UNT E-mail gateway, please
 contact Bahram Paiani at
postmaster@unt.edu.
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Helpdesk FYI
By Richard Sanzone, CITC Helpdesk Manager

View Options in Microsoft Outlook

Since many of us are switching over to Microsoft Outlook, today we will look at just a few
 of the view options available in Outlook. Under View (Alt V) there are several settings
 that we want to examine, namely the Navigation Pane, To-Do Bar, Reading Pane, and

Auto Preview.

The Navigation Pane is located on the left side of Outlook. This pane allows for
 navigation between your mail folders, calendar, contacts, and tasks. It also allows
 for navigation between your various mail folders such as inbox, sent mail, and trash.
 To change the settings for the Navigation Pane go to View > Navigation Pane.

Three options are available. Full allows for a detailed view of the items under your
 Navigation Pane, while minimized condenses the Navigation Pane to a thin bar.  To
 quickly expand a minimized Navigation Pane (or any minimized Pane) simply click
 on the >> symbol at the top of that pane. 
To quickly minimize a pane click the <<
 symbol.  You may also select Off to completely hide this pane.

The Reading Pane is located in the center of outlook.  It allows messages you select
 from a folder (such as inbox) to be opened in the current window.  Three options are
 available under View for the Reading Pane: right, bottom, and off.  Right and
 bottom determine the location of the reading pane.  If you wish for your messages to
 be displayed in a new window choose off.

The To-Do Bar is located on the right side of Outlook.  This Bar by default shows a
 calendar (date navigator), meeting or appointment summaries, and scheduled tasks. 

Under View > To- Do Bar you can find several view options such as full,
 minimized, and off.  You may also select what is displayed in the To-Do bar (date
 navigator, appointments, etc.)

One more interesting option under View is the Auto Preview function.  This allows
 messages in the inbox to be displayed with a small preview of the complete
 message.  You can toggle this function on or off by clicking on Auto Preview under
 View.


Since Christmas is fast approaching you may want your Outlook calendar to be a little
 more festive, maybe a nice Christmas green. To do this go to Tools > Options >
 Preferences > Calendar Options.  Now click on the Pull Down Menu next to Default
 Color and choose your color ( I decided on the first green). Click okay, and enjoy your
 more festive calendar.
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From the Help Desk
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IRC News
Minutes provided by Sue Ellen
Richey,
 Recording Secretary*

November 20, 2007
VOTING MEMBERS PRESENT:   PHILIP TURNER, CHAIR, PATRICK PLUSCHT, TIM CHRISTIAN, ELIZABETH HINKLE-TURNER,
 JOHN HOOPER, JUDITH ADKISON, BRUCE HUNTER, JIM BYFORD (for SCOTT WINDHAM), GARY MATTHEWS, UWE ROSSBACH,

YUNFEI DU, FRANCES MAY NON-VOTING MEMBERS PRESENT:  MAURICE LEATHERBURY, PHILIP BACZEWSKI, SUE ELLEN
 RICHEY (Recording Secretary) MEMBERS ABSENT:  ROBERT NIMOCKS, LOU ANN BRADLEY, DON GROSE ,  JOHN PRICE, WILL

SENN, RAY BANKS, ABRAHAM JOHN, CENGIZ CAPAN, JON NELSON, DONNA KEENER, RAMU MUTHIAH, NOREEN GOGGIN
 GUESTS PRESENT:  KEITHA ROBERTSON

The minutes of the October 16th meeting were approved with one correction: 

Paul Hons attended the meeting as proxy for Judith Adkison.

Distributed Computing Support Management Team**

Philip Baczewski reported for the Distributed Computing Support Management Team that
 DCSMT met on November 9. Bahram Paiani presented an overview of issues which lead to
 the unscheduled replacement of the top-level main routers with devices from IronPort. He
 explained that there had been a dramatic spike in e-mail connection attempts which the old
 mailhost servers could not handle without significant delays in mail delivery. The IronPort

devices had been operating in parallel for several weeks with no problems. Placing them in
 production increased an efficiency in mail handling but changed the method in which spam
 messages are identified and quarantined.

Also at that meeting, Keith Cullum of Dell Inc. introduced John Forshay as our new Dell

account representative for UNT. Keith has accepted a promotion at Dell and John will take
 over the role that Keith played. In addition, Mark McClung from Dell was in attendance and
 will be the primary marketing resource for Dell server technologies. John mentioned that our
 inside sales contact has also changed and promised to relay complete information for
 redistribution to distributed support managers.

Distributed support managers were urged to review the test implementation of the ITSM 7

system slated to replace Remedy. The next meeting is scheduled for December 7 and will
 feature updates on the MS Exchange migration and the MS Active Directory

implementation.

Dr. Turner asked if a notice would be going out explaining where to look for mail that is
 labeled as SPAM, so that people can know how to check it out. Philip replied that Bahram
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reportedly said that he could send weekly notifications, but didn’t really feel it was

necessary since these new units are much more efficient at weeding out only SPAM. 
 Discussion followed regarding the rules of the new
IronPort system, during which Judith
 Adkison reported that some faculty are reporting problems receiving mail from valid

sources. Also Dr. Turner reported that several times while he was away from campus he
 found that he could not connect to GroupWise remotely because the site he was accessing
 from had been blocked. Uwe Rossbach commented that he wanted to be sure that faculty did
 not miss mail-host items and government notifications.

Learning Enhancement Planning Group 

Patrick Pluscht reported for the Learning Enhancement Planning Group that the transfer of
 courses from Vista to new Vista 4.2 continues to go well. They completed migrating the
 1100 sections that were offered this
Fall, as of end of October. Now they’re going back and
 picking up any exceptions, courses that were offered in
Spring but not in Fall that faculty
 would like to have offered again next Spring, as well as any new courses. On November 12
 they released to the Learning Enhancement Planning Group the usability testing results of
 the learning management systems alternatives they are looking at, for their review. On
 December 5 they will see if they have enough evidence to narrow the selection.

Patrick presented the enrollment data for
Fall 2007, which showed 37,530 semester credit
 hours through internet courses (which does not include video conference courses). There
 were 12,710 enrollments representing 9,739 students; and those are the ones that are 50% or
 more. There was no way to capture data for those that are less than 50%. He also reported
 that they are in the implementation phase of Apple iTunes U. Once in place, they will begin
 to present training for faculty, during the Spring semester, and roll out some of the services. 
 In the meantime there is a lot to be done to with organizing the site as to how to use it for
 instructional and promotional University relations-type matters.

There will be scheduled downtime for both Vista as well as Vista 4.2 in order to physically
 move the servers, beginning at 6:00 am on December 18 and ending by 10:00 pm on

December 21.  Any attempts to access the service during scheduled maintenance windows
 will result in redirection to a notification page set up by Distributed Learning Support.   

Communications Planning Group

Tim Christian reported for the Communications Planning Group that the committee
 discussed the virtual side of networking, like VPN. The VPN project is something that
	Datacomm has been working on for some time. Joe Adamo said that they hope to have
 something to put into production by mid to late Spring. C.R., Chevli said they want to
 propose a maintenance window when they can conduct regular system maintenance, and he
 will soon present that proposal to DCSMT. Also, Joe Adamo announced that the firewall in
 Richardson will soon be brought to the UNT campus, doesn’t expect that this architectural
 change will not bring about any downtime.  Some dorms are using Apogee ISP, a third-party
 internet provider, in lieu of UNT’s service, with more dorms changing over in the near

future. There were some concerns raised regarding UNT’s existing wireless network, which
 was put in place as a secondary lower-priority network not to be used as for primary
 productivity by faculty, staff or students. There was some discussion about reviewing that
 criterion to move to making it a more fully productive solution.
Datacomm will take the

comments under consideration. 

Elizabeth Hinkle-Turner commented that RESNET is second in line if Apogee is not
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 available to take a call; and they are expanding some of their other services, also. The
 RESNET administrators don’t just administer the dorm services; they also handle the
 gaming areas, etc.

There was some discussion regarding the establishment of a schedule for computer system
 maintenance, and importance of coordinating that with network managers and critical

system administrators.  Tim assured everyone that C.R. Chevli would present the proposal to
 DCSMT first and then take it to other appropriate groups for approval before putting it into
 effect. 

EIS Planning Group

John Hooper reported for the EIS Planning Group that the upgrade of the Learning Solutions
 module is scheduled for the Thanksgiving weekend.  In addition, they are putting in the new
 database operating system and upgrading the system hardware.  They have been doing quite
 a bit of testing including load testing, and a mock “Go-Live” test, and believe they are ready
 for this upgrade.  If all goes well throughout the weekend, and after final checks on Sunday,
 they will move into production mode by Monday morning.  If there are serious problems,

they can always revert back to the old system; it will still be there.  They plan to trade in one
 of the old 6800 machines, but keep the others for backup machines, or testing machines.

John Hooper assured everyone that there had been no changes made to DARWIN; it is its
 own system, and runs separately. 

Standards & Policy Planning Group

Tim Christian reported for the Standards & Policy Planning Group that Andrew Harris and
 Bonita Hairston have now received the revised Computer Use Policy and the Electronic Mail
 Usage and Retention Policy, which were approved by the IRC at its last meeting.

Student Computing Planning Group

Elizabeth Hinkle-Turner reported for the Student Computing Planning Group that due to
 some hardware issues, an ad hoc committee has been formed and charged to look into the
 possibility of out-sourcing Eagle Mail.  A technical portion of this committee has met to

discuss the technical issues.  They are looking at the viability of Eagle Mail along with
 options from Google, Microsoft and Yahoo
Zimbra, considering security and functionality
 of each option. They have solicited task force members from various groups on campus,
 such as Registrar, Finance, Student Government, etc.  They have developed a list of
 technical questions and hope to have a meeting of the entire task force before the Christmas
 break and bring in some representatives from various companies in January and February
 and have a decision made by the end of February, 2008.

Tim Christian mentioned an article in Gartner about educational institutions adopting the free
 packages offered.  He also asked if Elizabeth’s committee had considered telling students
 they have to have an email account, and leave it up to them to get one from whatever source
 they choose.  Philip Baczewski noted that UNT now gives students the choice of providing
 their personal email address versus signing up for Eagle Mail.

New Emergency Notification System

Maurice Leatherbury reported that a new Emergency Notification System has been tested;
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 that was really an unplanned test.  He reported that they had live delivery of 17,000
 messages and 24,000 answering machines in 36 minutes, resulting in 86% successfully
 deliveries, if you consider answering machines.  The remaining percentage was a result of
 bad phone numbers, or unregistered numbers.  Tim Christian questioned the use of the
 Emergency Notification System for an accident on I-35, and Maurice replied that the
 decision to use the system was made by the University President.

Microsoft Outlook 

Maurice Leatherbury also reported that 64 people in CITC have been using Microsoft
 Outlook successfully.  The rest of the CITC staff will be migrated to Outlook next week. 

There being no further business, the meeting was adjourned at 3:05 p.m. 

* For a list of IRC Regular and Ex-officio Members click here.

**DCSMT Minutes can be found
here.

 

IRC
Meeting Schedule
The
IRC generally meets
on the third Tuesday of each month, from 2-4
p.m., in the
 Administration Building Board Room.
From time to time there are planned exceptions to
 this schedule. The schedule can be found
here. All meetings of the IRC, its program
 groups, and
other committees, are open to all faculty, staff,
and students.
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RSS Matters

This month we have another "golden oldie" column. This article first appeared in the
August

2004 issue of Benchmarks Online. Link to the last RSS article here:
Open Source
 Technology in the Classroom - Ed.

Moderators and Mediators

By Dr. Mike Clark, Research and Statistical Support Services Consultant

As is the usual case, I offer some discussion on a topic which I am currently exploring that
 has come up due to requests of some who have come into the office.  This time the focus is
 on moderators and mediator variables in multiple regression, with applications of how to
 implement such analyses using various resources.  In multiple regression we analyze the

predictive ability of two or more independent (predictor) variables for a dependent variable. 
 We are typically interested in a measure of the total variance in the dependent variable
 explained by our predictors, as well as the relative importance of the various predictor
 variables.

The first thing to do is to determine which type of relationship we are interested in, one that
 involves a moderator or mediator, and this can be somewhat confusing because some
 incorrectly use them interchangeably or might reference one when they mean the other.  For
 those familiar with typical analysis of variance, a moderator will probably seem
 straightforward in its interpretation.   It is simply a variable that interacts with another
 variable in predicting the dependent variable.   With the mediator we have a somewhat
 different relationship between the predictor variables, such that one variable in effect
 accounts for the relationship between an independent and dependent variable.  Each of these
 will be discussed in turn.

Moderators

As mentioned, moderators in multiple regression analysis have a parallel to interactions seen
 in ANOVA, the primary difference being that now we can involve continuous predictor

variables.   The picture below shows an example of an interaction between two two-level
 categorical variables in ANOVA.
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In typical analysis of variance, interactions are part of the output by default.   In multiple
 regression, interactions are not as often looked at, and usually must be specified.  Below is
 an example of how to do so through the menu system of S-Plus.   First enter your main
 effects, followed by the interaction and then you are all set.  Depending on the stat package
 used this may or may not be an option in the menu system.   An alternative method is to
 create an interaction variable as simply the product of the two variables in question. For

example in SPSS one can create the interaction term as the product of the two main effect
 variables, which is easily accomplished using the Transform/Compute menu.
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In testing for moderators, continuous variables should be centered.  This is done by simply
 transforming the variable to one in which the mean is subtracted from each response.   In
 addition, categorical variables must be transformed using dummy or effects coding.  Baron
 & Kenny (1986) even suggest that for a continuous X categorical interaction one could
 dichotomize the continuous variable under certain conditions.  The reasons for transforming
 variables are somewhat technical, and rather than go into it here one is invited to consult
 Aiken & West (1991) for the details.   The gist is that some sort of transformation of the

variables will need to occur in order to test for interactions. 

The diagram below offers an overview of what we are looking at in determining if a variable
 moderates the effects of another variable.  If path c is significant then one variable can be
 seen to moderate another.  If this is the case one must be cautious in their interpretation of
 significant main effects, as they can be seen as a reflection of the underlying interaction.

Mediators
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Mediator variables account for the relationship between a predictor and the dependent
 variable.  An example that might work here comes from my old job in the Counseling and

Testing department here on campus, where one of the many tests proctored there is the
 Graduate Record Exam.  Many international students take the test, and many do not do so
 well on the verbal portion of the exam.   Rather than claim some relationship between
 ethnicity and verbal ability, one would probably find that English language proficiency
 mediates the relationship between ethnicity and scores of verbal ability.   In other words,
 these people may in all actuality be very proficient in their general verbal skill, but as
 English is perhaps not their strong suit, they may have difficulty with this particular exam’s

 way of testing that skill.   Another example would be if someone administered an
 intelligence test to school age children and proclaimed a relationship between shoe size and
 intelligence.   One could probably think of any number of variables that could act as
 mediators for that relationship.

To test for mediators, one can begin by estimating three regression equations: (1) the
 mediator predicted by the independent variable, (2) the dependent variable predicted by the
 independent variable, and (3) the dependent variable predicted by the mediator and
 independent variable.  To begin with, we must have significant relationships found for the
 equations (1) and (2).  Then if the effect of the IV on the DV decreases dramatically when
 the mediator is present (e.g., its effect becomes nonsignificant), then the mediator may be
 accounting for the effects of the independent variable in question.   Overall power for

 equation (3) is diminished due to the correlation between the independent variable and
 mediator, and so rigid adherence to the p-value may not tell the whole story.  Also look at
 the size of the coefficients, namely, if the coefficient for the independent variable diminishes
 noticeably with the addition of the mediator to the equation.

In examining possible mediation, the Sobel (1982) test offers a significance test in which a z
 score is calculated such that we can determine whether the indirect effect of the IV on the
 DV by means of the mediator is significantly different from zero.  Given the output of the
 regression equations (1) and (3) above we have all we need to calculate the statistic. 

Calculate a, which equals the unstandardized coefficient of the IV when predicting the DV
 by itself, and its standard error sa.  From the equation (3) take the unstandardized coefficient
 b for the mediator and its standard error sb.  To obtain the statistic, input those calculations
 in the following variant of the Sobel’s original formula:

For an online calculation of the statistic see the following website:

http://www.psych.ku.edu/preacher/

To summarize with a diagram as we did with moderators, see the figure below.  When the
 relationships noted by paths A and B are controlled one should see an attenuation of the
 effect denoted by path C.  Note that there are other means for testing mediation and other
 factors to consider when doing so.  One is encouraged to consult the resources listed below
 as a starting point.

 

http://www.psych.ku.edu/preacher/
http://www.psych.ku.edu/preacher/
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Conclusion

This month’s Benchmarks Online article offered an introduction to moderators and
 mediators.   Moderators and mediators may be able to offer more to the story of the
 relationships among variables in multiple regression.  Things can get more complicated than
 presented here, including using both moderators and mediators in an analysis.  However, if
 theory suggests such avenues of research, one should be able to accomplish such analyses
 with modern statistical packages and/or a little elbow grease.

Resources

Aiken, L.S., & West, S.G. (1991). Multiple regression: Testing and Interpreting
 Interactions.  Sage Publications.


Baron, R.M., & Kenny, D.A. (1986).   The Moderator-Mediator Variable Distinction in
 Social Psychological Research: Conceptual, Strategic, and Statistical
 Considerations.  Journal of Personality and Social Psychology, 51(6), 1173-1182.


Holmbeck, G.N. (1997), Toward Terminological, Conceptual, and Statistical Clarity in the
 Study of Mediators and Moderators: Examples from the Child-Clinical and Pediatric
 Psychology Literatures.  Journal of  Consulting and Clinical Psychology, 65(4), 599-
610.

MacKinnon, D.P., Warsi, G., Dwyer, J.H. (1995).   A Simulation Study of Mediated Effect
 Measures.  Multivariate Behavioral Research, 30(1), 41-62.

Schroeder, L.D., Sjoquist, D.L., & Stephan, P.E. (1986). Understanding Regression
 Analysis.  Sage Publications.
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Short Courses
By Claudia
Lynch, Benchmarks Online Editor

Short Courses are over for the semester. Surf over to the Short Courses page to
 see what sorts of classes may be offered next semester. If you have a group that

needs a specific class, it may be possible to arrange a special class just for them
 . See "Customized Short Courses" below for further information.

Due to staffing and organizational changes, instructor-led courses offered in the
 past under the "Wide Area Network & Information Systems Courses"
 subheading such as "Getting Started with Dreamweaver" and "Moving from
 FrontPage to Dreamweaver" will not be taught this fall. According to the
 Central Web Support FAQ
page: 

Microsoft FrontPage: As Microsoft is dropping support for
 FrontPage, CWS is no longer supporting the FrontPage application
 or server extensions. Please migrate your site to Adobe’s
 Dreamweaver or contact Central Web Support at cws@unt.edu for
 more information.

Besides the FAQ page listed above, Central Web Support also hosts a
tutorials
 page. You can consult the new computer based training website to see what
 offerings are available there also:
http://www.unt.edu/cbt/

Customized Short Courses

Faculty members can request customized short courses  geared to their class
 needs from ACS. Other groups can
request special courses also. Contact ACS
 for more
information (ISB 119, 565-4068, lynch@unt.edu).

Especially for Faculty and Staff Members

In addition to the ACS Short Courses, which are available to students, faculty
 and staff, staff and faculty members can take courses offered through the
 Human Resources Department, and the Center for Distributed Learning.
 Additionally, the Center for Continuing Education and Conference Management
 offers a variety of courses, usually for a small fee.

EIS training is available. Questions or comments relating to EIS training should
 be sent to the EISTRN GroupWise account.

Moving from GroupWise to Microsoft Outlook Training

Although the project has been
delayed,  a useful source for finding resources for
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 preparing the campus community for this transition can be found here.

Central Web Support

Consult Central Web Support for assistance in acquiring “Internet services and
 support.” As described on their
website: 

Services include allocating and assisting departments, campus

organizations and faculty with web space and associated applications.

Additionally, CWS assists web developers with databases and associated
 web applications, troubleshooting problems, support and service.

 
In addition the Central Web Support office provides training to faculty and
 staff for web development. Training courses that are offered include

Dreamweaver, Fireworks, Integrating Dreamweaver and Fireworks,
 ColdFusion, Zope and SQL. 

 
In an effort to provide the services that the UNT Web Development

[requires] our staff will continually add additional courses to fit the needs
 of our faculty, staff and students.

Center for Distributed Learning

The Center for Distributed Learning offers courses especially for Faculty

Members. A list of topics and further information can be found
here.

The center also offers a "Brown Bag" series which meets for lunch the first

Thursday of each month at Noon in Chilton 245. The purpose of this group is to

bring faculty members together to share their experiences with distributed

learning. One demonstration will be made at each meeting by a faculty member

with experience in distributed learning. More information on these activities can
 be found at the Center for Distributed Learning Website.

UNT Mini-Courses

There are a variety of courses offered, for a fee, to UNT faculty, staff and

students as well as the general public. For additional information surf over to

http://www.unt.edu/minicourses/

Alternate Forms of Training

Many of the General Access Labs around campus have tutorials installed on

their computers. See http://www.gal.unt.edu/ for a list of labs and their
 locations. The Willis Library, for example, has a
list of Tutorials and Software
 Support.

The Training Website has all sorts of information about alternate forms of
 training. Computer Based Training (CBT) and Web-based training are some of
 the alternatives offered.

For further information on CBT at UNT, see the CBT website. Note, also, the
 articles in the July issue of Benchmarks Online, "Get Revved Up for Office and

Outlook 2007!" and "SkillPort Training Site Update." See also, "Free and
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 Legal: Copyright Advice and Training Online", "Office 2007 Training
 Available at the SkillPort CBT Website" and
"The Gift that Keeps on Giving:
 Even More Outlook and Office 2007 Training Posted on the CBT Website" .
 Finally, the November issue of Benchmarks Online contains the article
"New
 Titles Added in SharePoint Server 2007, Publisher, Project, and Office 2007."
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Staff Activities
Transitions

New Employees:

Chantel Taylor, Student Computer Operator (part-time).

Hsiao-Shan (Sharon) Huang, Student Assistant, Messaging, Enterprise
 Systems Technical Services (part-time).

Emily Nicole Schlebach, Student Assistant, Planning and Administration
 (part-time).

Adrian C. Rollett, Computer Systems Manager, Central Web Support,
 Enterprise Systems Technical Services.

Jennifer L. Moore, Student Assistant, Administration and Planning 
 (part-time).

No longer working in the Computing and Information
 Technology Center:

Mark Eblen, Student Assistant, Data Communications (part-time).
 
Miriam (Jennifer) Wilie, Student Assistant, Enterprise Systems
 Technical Services (part-time).

Changes, Awards, Recognition, Publications, etc.

InHouse prize winners

Lucky Ronny Seay, Production Control Specialist, Production Control,
won tickets to

the Mean Green Nov. 24 home football game versus Western Kentucky University.

 

Congratulations to Brenda Kirk, Computer Systems Manager, Distributed Computing
 and Imaging Services, on winning a T-shirt gift pack in an
InHouse drawing.

CITC employees lauded for working over the Thanksgiving break

As noted in InHouse on
November 30: 



While most people were eating turkey and dressing, and pumpkin pie during the
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 Thanksgiving break, many UNT staff members gave up their holiday to work on
 the upgrade of the University Enterprise Information System, or EIS. 

John Hooper, executive director of administrative information systems, says
 there were more than 100 employees involved with the upgrade of the EIS
 Learning Solutions 8.0 system to Campus Solutions 8.9 version of the software.
 Teams from the Computing and Information Technology Center, Academic
 Affairs, Toulouse School of Graduate Studies, Finance and Administration and
 Advancement were all involved with the enhancement.

Soaring Eagles

Congratulations to all the CITC Soaring Eagles, who were recognized in the December
 2007/January 2008 Human Resources Newsletter, HR Connections:

Brian Adams, Microcomputer Consultant, Helpdesk (part-time).

Donna Cagle, Administration and Planning Administrative Assistant.

Daniel Harris, Microcomputer Consultant, Helpdesk (part-time).

Jennifer Lafleur, Assistant Director for Computing and IT Planning and
 Administration.
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